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What is EndNote? 
 
EndNote is a software application that can be of considerable help in several key 
aspects of your work – those that involve keeping track of, and making good use 
of, the references on which much of your work is based: 
 

1. EndNote gives you a database foundation in which to store, organise and 
retrieve reference data. This is like a very sophisticated card file in which 
you can keep track of what you have read, search for relevant references 
to read, download and store full-text articles, and share your reference 
data with colleagues. 

 
2. EndNote is an on-line search tool. If you or your library have access to on-

line bibliographic resources you can search them and retrieve 
appropriate data directly into your reference database. 

 
3. EndNote provides powerful assistance in generating text citations and 

bibliographies in articles that you are writing. Its “CWYW” (“Cite While 
You Write”) facilities are of enormous help in the otherwise tedious 
preparation of citations and bibliographies accurately formatted in the 
particular style of the publication for which you are writing  

 
There are other examples of bibliographic software available on the current 
market, but EndNote is at present by far the most widely used, particularly in 
Australia and New Zealand. Almost all universities in this region have site 
licences enabling them to distribute free working copies to their staff and 
students, as do many other educational institutions, government departments 
and business organisations. Single or multiple-licence copies can be purchased 
from Crandon Services Pty Ltd (info@crandon.com.au), who also provide free 
technical support to Australian or New Zealand users. 
 
Where to look for help? 
 
If convenient, you might like to start by going to www.crandon.com.au. On the 
home page, you will see a list of links headed Tutorials, and in that list a link to 
Help & Tutorials . Click on that link to the Help and FAQs page with a YouTube 
Tutorials link, under the Help submenu, which should take you to a series of 
brief tutorials that you may find to be very helpful. Try the first (Bibliographies 
Made Easy) for a simple introduction to the main features of EndNote as a 
bibliographic writing tool. 
 
You may be able to find the same tutorials on-line at www.endnote.com, if you go 
to Support and Services and then to Guides and Information > EndNote Xx > 
Basics On-Line Tutorial. 
 

mailto:info@crandon.com.au
http://www.crandon.com.au/
http://www.endnote.com/
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If you have a copy of EndNote installed on your computer (see below for a brief 
discussion of installation procedure), check the EndNote program/application 
folder for a file called GettingStartedGuide.pdf. This guide, which covers 
approximately the same ground as these notes, is also easily readable and we 
strongly recommend that you take advantage of it. If you don’t yet have access to 
an installed copy of EndNote, you can download a copy of the Getting Started 
guide from 
 
http://endnote.com/support/helpdocs/ENX4_GettingStartedGuide_WinMac.pdf 
 
or go to www.endnote.com > Support and Services  > Guides and Information 
> EndNote Xx > Getting Started Guide. 
 
When you do indeed have EndNote installed on your computer, do not forget its 
very comprehensive Help file, which is much more detailed than the Getting 
Started document. If you don’t yet have EndNote installed but would like to 
check the more detailed file, you can download a copy from 
 
http://endnote.com/support/helpdocs/EndNoteX4Help.pdf  (Windows) 
 
http://endnote.com/support/helpdocs/EndNoteX4MacHelp.pdf  (Macintosh) 
 
or go to www.endnote.com > Support and Services > Guides and Information 
> EndNote Xx > Help Documentation (separate Windows or Macintosh 
versions). 
 
 
Getting Started – Installation 
 
1. If necessary, first obtain and install an EndNote-compatible word processor. In 
principle EndNote can work with any word processor that can save its 
documents in RTF format, and that includes nearly all of them. In practice, 
however, it is particularly convenient to use one of the word processors that can 
work with EndNote’s “CWYW” (“cite while you write”) facility, which is limited to 
Microsoft Word on Windows or Macintosh platforms, Apple Pages on a 
Macintosh, or OpenOffice Writer in Windows. Use of either Pages or OpenOffice 
Writer also has some significant limitations by comparison with Word and for 
most practical purposes Word is at present thought to be more convenient.  
 
We recommend that you work if possible with the most recent versions of both 
EndNote and Word. At the time of writing EndNote X4 (Macintosh) is compatible 
with Word 2004, 2008 and 2011, and EndNote X4 (Windows) is compatible with 
Word 2003, 2007 and 2010. If for any reason you are obliged to work with a 
different word processor, feel free to contact Crandon Services for advice on 
possible limitations and workarounds. The following notes assume a valid 
EndNote/Word configuration. 
 
2. Now you can obtain and install a copy of EndNote. The installation procedure 
is straightforward, but if you have no previous experience with EndNote, or only 

http://www.endnote.com/
http://endnote.com/support/helpdocs/EndNoteX4Help.pdf
http://endnote.com/support/helpdocs/EndNoteX4MacHelp.pdf
http://www.endnote.com/
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limited experience with application installation on your computer, we strongly 
advise you to begin by reading the Installation chapters in EndNote’s 
GettingStartedGuide.  
 
Almost all universities in Australia and New Zealand currently have EndNote site 
licences for their staff and (most of them) for their students, as have many 
government departments and commercial enterprises. If you are fortunate 
enough to have access to one of these licences then you should be able to get a 
copy that you can use free of charge during the term of the licence. Alternatively 
single copies or multiple-copy licences can be purchased from Crandon Services 
Pty Ltd (www.crandon.com.au). You can download a free trial copy (from 
Crandon or from the EndNote home site at (www.endnote.com) which is fully 
functional but will revert in 30 days to limited capabilities. It should prove to be 
perfectly adequate for trial purposes, and it can be upgraded to a licensed copy 
without losing any of your trial results. 
 
Remember, you must install Word (as a component of Microsoft Office) first, and 
then and only then install EndNote. It is important to install in this order, as when 
EndNote is installed it looks for compatible word processors and then 
automatically installs the necessary links. If you install EndNote first these 
essential links will not be established. 
 
Installing EndNote on a Windows platform 
 
The installation procedure for a Windows platform is as follows (the procedure 
for a Macintosh installation follows below): 
 

1. Log in to the local machine with administrative rights or as a user 
with program installation privileges. Make sure no applications are 
running, including virus protection software, Microsoft Word, or 
OpenOffice.org applications. 
 
The OpenOffice.org Quickstarter may appear in your System tray. 
Right-click on the icon and choose Exit Quickstarter. 
 
2. Start the EndNote installation program. 
If you downloaded the EndNote installer: Double-click the installer 
file to start the EndNote Setup program. 
If you received EndNote on a CD: Insert the CD into your CD-ROM 
drive. 
The EndNote Setup program will start. If you do not have Autoplay 
enabled, choose Run from the Start menu, type 
 
“d:\setup” (use the drive letter appropriate to the drive containing the 
installation CD) and press ENTER. 
 
3. Now follow the instructions on screen to complete the installation. 
Use the Next button to move forward between the installation dialogs. 
 

http://www.crandon.com.au/
http://www.endnote.com/
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Welcome: Thank you for selecting EndNote! 
 
Registration Information: If you are installing the full version of 
EndNote, enter your EndNote product key. You must enter a valid 
product key to continue with installation of the full version of 
EndNote. The product key can be found in the EndNote X4 CD 
packaging, or on the order confirmation of your digital product. 
 
If you are installing the Demo version, choose the appropriate button. 
You do not need a product key or serial number to install the Demo 
version of EndNote. 
 
User Information: Enter your name and organization. If you are 
upgrading from a previous version, you must also enter your previous 
EndNote serial number. 
 
Read Me Information: Read late-breaking news about this version of 
EndNote. 
 
Windows Mobile Read Me Information: Read late-breaking news 
about EndNote for the Windows Mobile OS. 
 
End User License Agreement: You must select “I accept the license 
agreement” in order to continue with the installation. 
 
Select Installation Type: Typical installs the most popular output 
styles, filters, and connection files. Limiting the number of files 
installed speeds up performance. Advanced users can choose Custom 
to hand pick the file groups to install, and add additional styles, filters, 
and connection files. 
 
Select Destination: By default, EndNote is installed in the C:\Program 
Files\EndNote Xx folder (e.g. EndNote X4). You can use the Browse 
button to change the folder selection if you wish. If a previous 
installation of EndNote is found in the same folder, you will be given 
the option to either back up or overwrite the older files. If you back up 
files, they are placed in a Backup folder in the installation folder. 
 
Select Components: (Custom installations only) If you selected a 
Custom installation, see the Installation chapter in EndNote Help. 
 
Select Default Citation Manager: (Microsoft Word 2007 and 2010 
only) If the installer detects Microsoft Word 2007 or 2010, it asks 
whether to “Use EndNote as my default citation manager.” Cite While 
You Write will be installed in Word 2007 or 2010 in any case, but 
when this item is selected the installer will hide Word’s native 
Citations and Bibliography commands (the group normally found on 
the References tab in Word) in order to avoid confusion for the user. 
 



6 
 

Ready to Install: You can still click Cancel to stop the installation. 
Once you click Next, the installation program will begin installing 
EndNote files. 
 

4. On the final “EndNote Xx is Successfully Installed” dialog, click Register 
to register your copy of EndNote, or click Finish to close the 
installation program. 

 
 
Checking a Windows Installation of EndNote: 
 
To run EndNote, click the Start button, choose All Programs, select EndNote, and 
then choose EndNote Program. 
 
First, a dialog may ask whether you want to open a new EndNote Web account or 
integrate with an existing EndNote Web account. EndNote Web is a valuable 
component of the EndNote system and you should become familiar with it as 
soon as your experience permits. However to keep things reasonably simple it is 
not treated in this brief introduction. Decline the invitation for now. You can set-
up an EndNote Web account at any later time from within EndNote. 
 
Next, a dialog may ask you to open a library file. You can create a new library or 
open an existing EndNote library, or choose Cancel or Close. A shortcut to the 
Sample Library is provided in the Examples folder, normally listed at the end 
within the EndNote Program folder, to help you get familiar with EndNote. 
Navigate to the Examples folder (in the EndNote Program folder) and double-
click Sample_Library_X4.enl to open it. If you don’t see the .enl file in the 
Examples folder, look for its .enlx compressed equivalent. Double-click that and 
it will automatically expand to the regular working version. 
 
Note that when expanded the library actually consists of an .enl file and a 
Sample_Library_Xx.Data folder. EndNote libraries always consist of .enl library 
files, each accompanied by a matching Data folder. If copying a library file from 
one computer to another always be sure to copy the .Data folder too – much of 
the information stored in the library may actually be stored in that folder.. 
 
To check the version number of EndNote that you have installed, choose About 
EndNote from the Help menu. Click the splash screen to clear it. 
 
If you have trouble accessing the program, repeat the installation steps to verify 
that the program was correctly installed. 
 
To see whether Cite While You Write is correctly installed, start Microsoft Word 
(or the OpenOffice.org Writer if that is your word processor of choice). 
 
In Word 2003, click on the Tools menu and you should see EndNote’s CWYW 
commands on an EndNote Xx submenu. In Word 2007 and 2010, you should see 
them accessed from an EndNote tab. In OpenOffice.org Writer, you should see 
EndNote commands on an EndNote Xx menu. 
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(Remember that Cite While You Write commands may not be available if you 
installed or upgraded your word processor after installing EndNote.) 
 
If Cite While You Write commands do not appear in Microsoft Word or 
OpenOffice.org Writer, repair the EndNote installation: 
 

1. Log in to the machine with administrative rights or as a user with program 
installation privileges. 

 
2. Make sure that all Microsoft Office and OpenOffice.org applications are 

closed, including any Quickstarter applications. The OpenOffice.org 
Quickstarter may appear in your System tray. Right click on the icon 
and choose Exit Quickstarter. 

 
3. From the Windows Start menu, select Control Panel, or choose Settings and 

then Control Panel. 
 

4. Choose Add or Remove Programs.  
 

5. Highlight EndNote X4 and click Change.  
 

6. Select Repair and click Next. 
 

Your entire EndNote installation should be checked and repaired as needed. 
For more information, see “No EndNote commands in Word” in EndNote 
Help. 

 
 
Installing EndNote on a Macintosh 
 
The installation procedure for the Macintosh platform is as follows: 
 

1. Make sure no applications are running—including any virus 
protection software and Microsoft Word itself. 
 
2. Start the EndNote installation program: 
 
If you downloaded the EndNote installer: Double-click the disk 
image to display an EndNote X4 folder. 
 
If you received EndNote on a CD: Insert the EndNote CD into your 
CD-ROM drive. If the installer does not launch immediately, double-
click the EndNote Xx Installer to display an EndNote Xx folder. 
 
3. Drag the EndNote Xx folder to the Applications folder on your hard 
drive. 
NOTE: The EndNote folder must reside in the Applications folder in 
order to use the Services menu from EndNote and in order to use 
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Spotlight searching. 
 
4. Double-click on the Applications folder, then the EndNote Xx folder, 
then the EndNote Xx application icon in order to launch EndNote and a 
Customizer program. 
 
5. Follow the instructions on the screen to complete the installation. 
Click the Next button to move forward as needed through the 
installation dialogs: 
 
Welcome: Thank you for purchasing EndNote!  
 
Registration Key: If you are installing the full version of EndNote, 
enter your EndNote product key. You must enter a valid product key 
to continue with installation of the full version of EndNote. The 
product key can be found in the EndNote Xx CD packaging or on the 
order confirmation of your digital product. 
 
If you are installing the Demo version, choose the button to evaluate 
EndNote. You do not need a product key or serial number to install the 
Demo version of EndNote. 
 
User Information: Enter your name and organization. If you are 
upgrading from a previous version, you will also need to enter your 
previous EndNote serial number. 
 
Read Me: Read late-breaking news about this version of EndNote. 
 
License Agreement: You must select “I accept the license agreement” 
in order to continue with the installation. 
 
Product Registration: Please register your copy of EndNote! 
 
When you start EndNote, a Customizer automatically installs Cite 
While You Write files for Microsoft Word 2004, 2008 or 2011 if any of 
them has been found on your computer. 

 
 
Checking a Macintosh Installation of EndNote: 
 
To run EndNote, double-click the EndNote Xx icon found in the 
EndNote Xx folder, within the Applications folder on your hard drive. 
 
If this is the first time you have started EndNote, a Customizer will attempt to 
install Cite While You Write files for Word. 
 
Next, a dialog may ask whether you want to open a new EndNote Web account. 
EndNote Web is a valuable component of the EndNote system and you should 
become familiar with it as soon as your experience permits. However to keep 
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things reasonably simple it is not treated in this brief introduction. Decline the 
invitation for now. 
 
A dialog will ask you to open a reference library file. You can create or open an 
EndNote library, or choose Close. A Sample Library is provided in the Examples 
folder, within the EndNote Program/Application folder, to help you get familiar 
with EndNote. Navigate to the Examples folder (/Applications/EndNote 
Xx/Examples/) and double-click Sample_Library_Xx.enl to open it. If you don’t 
see the .enl file in the Examples folder, look for its .enlx compressed equivalent. 
Double-click that and it will automatically expand to the regular working 
version. 
 
Note that when expanded the library actually consists of a .enl file and a 
Sample_Library_Xx.Data folder. EndNote libraries always consist of .enl library 
files, each accompanied by a matching Data folder. If copying a library file from 
one computer to another, always be sure to copy the .Data folder too – much of 
the information stored in the library may actually be stored in that folder.  
 
To check the EndNote version number, go to the EndNote menu and choose 
About EndNote. Click the splash screen to clear it. 
 
Checking to see whether Cite While You Write has been correctly installed: 
 
Start EndNote, then start Microsoft Word, and then select Word’s Tools menu. 
 
You should see EndNote’s Cite While You Write commands on an EndNote Xx 
(e.g. X4) submenu in Word.If you do not see these commands, Word support was 
not correctly installed in EndNote. Try any of the following three ways to re-
install CWYW (after each attempt, start EndNote and then Word to check for an 
EndNote submenu on the Tools menu in Word): 
 

1. Use the Customizer: 
a. Make sure no applications are running—including virus 

protection software or Microsoft Word itself. 
b. Start the EndNote program. 
c. From the EndNote menu, choose Customizer. 
d. On the “Component Selection” dialog, select the 

components you want to install (or keep installed) and click 
Next. 

 
2. Try reinstalling EndNote as described in the “EndNote Installation” notes 

above. 
 
3. Install the files manually as described in EndNote Help. 

 
 
A note on installed content files (Windows and/or Macintosh): 
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Over the years the EndNote team has developed and updated literally thousands 
of what it calls “content files”. These files contain information that EndNote uses 
to connect with external bibliographic databases (“connection” files), to filter 
bibliographic data imported from an external source (“filter” files) or to format 
citations and bibliographies in word processor documents (“style” files). At 
present, for example, there are almost 5,000 style files alone, each appropriate to 
one particular publication medium (e.g. one journal). Clearly there is no point in 
transmitting and installing all of these content files for any one user, or even one 
group of users. No one user is ever going to use more than a few of them at most. 
 
Accordingly the installation procedure will install only the most popular of each 
type of file, adding up to some hundreds rather than thousands of content files. 
Any of the remainder can be easily downloaded from the EndNote web site at 
www.endnote.com. Go to Support and Services and choose from the 
Downloads options. If you download one or more Style files, for example, copy 
them into the Styles folder in the EndNote Program/Application folder, and they 
will then be accessible to EndNote’s style selection tools (likewise for Filter or 
Connection files, which each have their own folders in the EndNote group). 
 
 
Cite While You Write preferences 
 
When you are satisfied that EndNote has been properly installed and that Word 
can access it from the Tools menu, you may wish to specify some basic 
preferences for CWYW operation. This can be done from that Tools menu, as 
follows: 
 
Word 2003 (Windows), 2004, 2008 or 2011 (Macintosh): From Word’s 
Tools menu, select the EndNote Xx sub-menu (e.g. EndNote X4), and from that 
sub-menu select Cite While You Write Preferences… : 
 

http://www.endnote.com/
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Word 2007 or 2010 (Windows): These versions of Word have no Tools menu. 
Instead the EndNote CWYW commands are accessed from an EndNote Xx tab, on 
which you can click the Preferences command: 
 

 
 

Either of these methods will produce a dialog for setting some routine 
operational parameters for calling and using CWYW within Word: 
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The General settings are mostly self-explanatory. Depending on which boxes are 
checked, Word will or will not automatically start EndNote whenever it is started 
itself, and/or close EndNote automatically when Word is closed. Some users find 
these facilities convenient, particularly when doing a lot of manuscript 
preparation. At other times they can become irritating – e.g. always opening 
EndNote when you only opened Word to write a short letter. Even if the first box 
is unchecked, EndNote can always be quickly accessed from Word’s Tools menu, 
and it can always be closed with no more than one mouse-click if Word doesn’t 
do the job itself. Just choose the preference that suits you. 
 
We suggest that you leave the other five boxes checked for the time being, and 
leave the scan time at 30 seconds. You can always come back and change these 
later if you wish. 
 
The Keyboard preference tab allows you to set keyboard equivalent commands 
for each of the basic CWYW operations. The Figures and Tables tab lets you 
specify whether to use default or custom placement of figures and tables relative 
to the remaining text. Again we suggest that you should leave these options as is 
until you have gained a little practical experience. 
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Finally, the Application pane offers a choice between EndNote and EndNote 
Web as the application in which you are currently planning to use CWYW. Leave 
this one at EndNote until you later get involved with EndNote Web. 
 
 
The EndNote Library window 
 
When you open an EndNote library, such as the Sample Library installed with the 
EndNote program, it will look something like this: 
 

 
 
(Note: This figure shows a typical Macintosh display. Windows displays differ a 
little in detail – e.g. in the actual icons in the top toolbar – but not in purpose.) 
 
This window has several key components (“panes”): 
 
Across the top of the window is a toolbar containing icons for some of the most 
common EndNote functions. These functions, which are user-selectable for the 
display (see later notes on setting general preferences), are also accessible from 
an EndNote Tools menu (not the same as the Word Tools menu). Those that you 
are most likely to use in routine operation are the New Reference, Insert Citation 
and Go To Word icons, whose purposes are self-explanatory. Note particularly 
the Style Selection drop-down menu, near the left end of the toolbar. You will use 
this menu frequently to select or change the formatting style for EndNote to use. 
 
On the left side of the window is the Groups pane. This is used to control the 
establishment, display and maintenance of sub-groups of references within the 
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main database. In the figured library, groups have been established for 
references in the main library pertinent to Palaeontology, Bats, Abstract Art and 
references obtained from on-line searches. Further sub-groups have been 
established for each of these groups. 
 
Across the bottom of the window a Tab Panedisplays a Preview tab to view 
formatted references, a Search tab for searching either the current library or an 
online database, and a Quick Edit tab allowing you to quickly edit a reference. In 
the figured example, the Tab pane is set to Preview a selected reference, in this 
case the Donnelly et al 1988 reference, in the style selected in the toolbar menu, 
in this case the formatting style for the journal Australian Journal of Earth 
Sciences. 
 
The main part of the window is the Reference List pane, which displays a multi-
column list of the references contained within the library. In the example the 
first column is set to show a paperclip icon for any references that include an 
attached file (e.g. a text or PDF file). The second column is the last name of the 
(first) author, the third the year of publication, the fourth the article title, and the 
fifth an indication of the reference type (i.e. journal article, book, book section, 
report, patent, thesis or any other of the 48 “standard” reference types that 
EndNote recognizes – it also has room for you to define more of your own if you 
wish!). 
 
The actual columns in this display and the order in which they are displayed are 
user-selectable. Any of the columns can be used to provide a basis for sorting the 
library simply by clicking the column heading. A small triangle in the selected 
heading indicates the direction of the sort order by pointing up or down; just 
click on it to reverse the sort order if you wish. 
 
To choose the fields (columns) displayed, and the order in which they are 
displayed, go to the Edit menu (Windows) or the EndNote Xx menu (Macintosh), 
choose Preferences, and then select Display Fields. 
 
From that same Preferences menu you can also choose Display Fonts to change 
the fonts used in the References List pane (click on the Library tab in the 
resulting dialog and select the font you want). Note: The Display Fonts 
preference dialog also allows you to change other fonts used by EndNote 
(General, Labels, Search tabs), e.g. for text typed in or for the display of other text 
outside the References List pane. We suggest that you leave these in their default 
settings until you are more familiar with EndNote. In particular we strongly 
advise you not to change those settings that by default use EndNote’s Plain Font 
and Plain Size. If it ain’t broke, no need to fix it! 
 
 
 
Individual Reference Data 
 
The Reference List pane of the library window only displays a small part of the 
information for each reference that may be stored in the library. To see more of 
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the complete details, you might begin by selecting (highlighting) a reference in 
the List window and checking the Preview pane at the bottom of the window. 
(If you don’t see that Preview pane, which has Preview, Search and Quick Edit 
tabs, then you should see a toggle labelled Show Tab Pane at the bottom right of 
the display window. Click on that box and the Preview pane should appear.) 
 
If necessary click on the Preview tab, and the selected reference will be 
displayed, formatted according to the style which is currently selected in the 
drop-down menu at top left of the display window. By default only a small 
number of styles will be displayed initially in the drop-down menu, but you can 
choose Select Another Style…, which will take you automatically to the contents 
of EndNote’s Styles folder, from which you can select others from the default list 
supplied. (And if none of those meets your requirements, you can download 
others from the thousands accessible from EndNote’s web page at 
www.endnote.com.) 
 
The Preview display is a great feature that you will use frequently when checking 
references for inclusion in a manuscript – but it still shows only that information 
which is necessary to format a reference for publication, unless you choose a 
style called Show All Fields from the Styles folder — try that one too! 
 

Alternatively, double-click on any desired reference in the List pane, and it will 
expand to a new window of its own: 
 

 
 

You can select a desired reference before expanding it by scrolling the List 
window, by using the up- and down-arrow keys to move through the list, or by 

http://www.endnote.com/
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typing the appropriate first few characters in the field by which the list has been 
sorted. For example, if the list is sorted by author name then typing “Don” at the 
keyboard, with the List window active, will change the list display to show only 
those references whose (first) author has a surname staring with those three 
letters. If there should then be more than one, it’s easy to locate and double-click 
the one you want. 
 
In the example figured above, the window heading of “Donnelly, 1988 #18” 
indicates that the data displayed is for a reference which has Donnelly as the 
(first) author, was published in 1988, and is no. 18 (record 18) in the library 
database. A toolbar at the top of the window has a drop-down menu at the left 
showing the reference type, and several icons for quick access to some of the 
reference editing or display functions. This toolbar is also user-configurable. 
 
The icon labelled “Toggle Empty Fields” is worth special mention. As you will see 
when you begin to enter your own reference data (see below), Endnote makes 
provision for many kinds of data that will not necessarily be entered for any one 
given reference. For example, it has an Abstract field for Journal Article 
references, but the information to fill that field will not always be available, and 
it is not usually required for bibliography-formatting purposes. 
 
Altogether EndNote allows for over 50 data fields for any one reference type, but 
for most references only a small proportion of those fields will ever be used. That 
means that a very large window would be required to show them all, even 
though most of them would be empty. However if you click on the “–“ side of the 
“Toggle Empty Fields” icon, empty fields will not be displayed when any 
reference is expanded. The resulting windows are usually more manageable. Feel 
free to experiment with this – whatever selection you toggle can easily be 
instantly reversed. 
 
Note that each reference in the library (each “record”, in database terminology) is 
made up of a number of fields. If you spend a few minutes looking at several 
different references, of different reference types, you will see that there are some 
fields common to all reference types, and some that are specific to individual 
types. For example, a Journal Article will have a field called Journal, in which it 
stores the name of the journal in which that reference was published. A Book 
reference has no such field, which would be totally irrelevant, but has other 
fields pertinent to books rather than other reference types. On the other hand, 
fields like Author (name) and Year are common to many different types. 
 
When looking at a few different references, notice some key features that will 
become very relevant when you are entering reference data for your own 
libraries. For example, you will see that for references with multiple authors, 
each author name is on a separate line in the Author field. Check also the use of 
commas in the entered names of individual authors. You may find that some 
names are entered with no comma at all (e.g. “Robert D. Smith”), while some 
have one comma (e.g. Smith, Robert D.”) and you may even see some with two 
commas (e.g. “Smith, Robert D., jnr). Think about this – and consider the problem 
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of a dumb computer trying to decide which part of a name is the surname, which 
part is the first name(s), and so on. We will come back to this question later. 
 
When you have finished reviewing a reference, close its window. Click on the 
Close button at the top of the reference window (careful – not the Close button 
for the whole List window, which will probably be just behind it!). Or select 
Close Reference from EndNote’s File menu. Or press Control-W on the 
keyboard (Windows) or Command-W on the keyboard (Macintosh). As usual, 
just pick the method that suits you best. 
 
 
Entering a Reference to a Library 
 
There are several different ways in which you can add reference data to an 
EndNote library: 
 
1. You can enter the relevant data from the keyboard. This is relatively slow and 
it can become tedious, but it may be the only method available to you. You 
should at least gain some experience with it to increase your familiarity with the 
EndNote files and to help you with the ability to edit data obtained in other ways. 
 
2. You can connect to some databases on-line, search them, and retrieve 
information from them for one or more relevant references, importing that 
information directly into EndNote without having to type anything. These 
services comply with a data transmission protocol called “Z39.50”. An example is 
Thomson-Reuters’ Web of Knowledge. For biological, particularly medical, 
applications, the best-known by far is the PubMed database, administered by the 
U.S. National Library of Medicine. If you work in the earth sciences, for example, 
you may be able to access the GeoRef database, maintained by the American 
Geological Institute, or its AusGeoRef subsidiary database (maintained by the AGI 
in conjunction with Geoscience Australia). Many other fields of knowledge 
maintain similar databases; check with your library if you are fortunate enough 
to have one. 
 
In such cases you don’t need to type anything other than your search criteria, 
and you can enter the data for dozens of references in a few minutes (though 
some editing may be required). However the on-line databases must themselves 
contain the data that you seek, and they are mostly commercially based, so that 
you need to have legal and practical access to them (PubMed access is free). If 
you work in a large tertiary institution your library may be able to arrange 
access for you, although not all universities, for example, subscribe to GeoRef or 
to the Web of Knowledge.  
 
Examples of this approach will be demonstrated below. If you believe that you 
may have access to one or more of the Z39.50 services then you should check 
with your library. You may also need to check with your network administrators 
to ensure that you will have on-line access through a proxy server, or whatever 
security system that your institution uses. 
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3. Similarly, a wide variety of organisations maintain bibliographic databases in 
formats other than the Z39.50 protocol required for the kind of direct access 
described in (2) above. These provide access to their databases either on-line or 
on regularly distributed CD-ROMs. You can search the databases for references 
relevant to your needs and you can download them to your own computer, but 
you cannot import the results directly into your own EndNote library as you can 
with the Z39.50 sources. Instead you must pass the downloaded data through an 
EndNote filter, which examines their text contents and translates them into a 
form that EndNote can recognise. You can then import the translated files into 
EndNote. Again virtually no typing is required, but the relevant services are all 
commercial and access to them is not free. Perhaps you have access to some of 
them through an institutional library, although few (if any) libraries can afford to 
subscribe to them all. 
 
These services include OCLC, OvidSP, Ebsco, Thomson Reuters and many others. 
EndNote comes with filters pre-constructed for most of them, and also with the 
tools to write your own filters or edit those already available. 
 
 
Keyboard entry of reference data 
 
For a quick exercise on keyboard entry, open EndNote and open the Sample 
Library. Once any library is opened you can add references to it or delete 
references from it. Of course you can also open any existing reference in the 
library file and edit it. 
 
Now open a new (empty) reference, using any of the following: 
 

1. Select New Reference from Endnote’s References menu. 
 

2. Click on the New Reference icon in the List window toolbar. 
 

3. Press Command-N (Macintosh) or Control-N (Windows). 
 
An empty reference window will appear, populated with the fields appropriate 
to the default reference type, and all you have to do is to select the correct 
reference type and then type the correct information into each appropriate field: 
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(This is a Macintosh example; the Windows equivalent will differ only in minor 
detail). 
 
The first sample reference to enter in this brief exercise is to a journal article, so 
make sure that this reference type is selected in the drop-down menu at top left. 
 
The Author field should be highlighted by default. If not click in it to highlight it. 
 
1. Now type in the name of the first author for the new reference: 
 

Yund, R.A. 
 
Enter everything into the EndNote library in plain text (i.e. do not use italics or 
bold face; if EndNote needs them for formatting it will apply them itself. You can, 
however, enter subscripts or superscripts if appropriate). 
 
Now press Return/Enter to set a new line in the Author field, and enter a second 
author: 
 
  G. Kullerud 
 
This (real) sample reference has only these two authors, so press Tab to advance 
to the Year field.  
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Notice that the two authors have been entered in different formats, one without 
any contained comma, and the other with one comma. EndNote will interpret 
them in this way. If there is no comma, the last word entered is the last name 
(surname), and anything before the last word is the first name(s). If there is one 
comma, then anything before the comma is last name, and anything after it is first 
name(s). If an entered name contains two commas, EndNote will assume that 
anything before the first comma is last name, anything between the two commas 
is first name(s), and anything after the second comma is a supplementary  title, 
as in the name” J. P. Smith jnr”, which would be entered as “Smith, J. P., jnr”. 
 
When formatting a reference in a bibliography, EndNote is clever enough to 
abbreviate a full first name to its initial, if that is what the formatting style 
requires. However it can’t do the reverse – if you enter only an initial then 
EndNote obviously can’t expand that automatically to the correct full name. So 
you should always enter authors’ full first names if possible. If it is necessary to 
enter initials, be sure to put either a space or a period between consecutive 
initials. That is, enter Smith J.O., or Smith, J O, or Smith, J. O. – but not Smith, JO. 
EndNote will think that the latter is somebody whose first name is “Jo”. 
 
These rules – a separate line for each author, and careful attention to the 
commas (if any) – are inflexible and responsible for some common entry errors. 
Are they important? Think now – how would you enter the name of Charles de 
Gaulle? In that form, without any comma, EndNote will assume that the last 
name is “Gaulle” and first names are “Charles de”. In a bibliography sorted 
alphabetically by last name, as normal, then that name will be listed in the Gs. If 
you want him in the Ds, as in “de Gaulle, Charles” then you must enter the name 
in that form, with the single comma. EndNote will then treat “de Gaulle” as the 
last name. 
 
The first time you enter a name in your EndNote database it will be shown on the 
screen in red. EndNote keeps close watch on names, and thereafter any time the 
same name is entered for another reference it will be shown in black (and when 
you start to type it in EndNote will leap ahead and suggest the rest of the name, 
which you can accept if you wish by pressing Tab). 
 
 
2. Now type 1966 in the Year field. Do not enter dates in the day-month-year or 
related formats in this field – just the publication year. If the detailed date is 
important, as it may be, for example, for reference to web pages or publications, 
then there is a separate Date field further down the list that you can use for that 
purpose. 
 
3. Press Tab to advance to the Title field, and enter the article title: 
 
Thermal stability of assemblages in the Cu-Fe-S system 
 
Titles should be entered without a period/full stop or any other terminating 
punctuation. EndNote will add it automatically if a specific formatting style 
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requires it. Do not press Enter/Return to create a new line for long titles – type 
the title as one line, allowing it to wrap to successive lines if needed. 
 
EndNote has some capability to control capitalisation when formatting, but it is 
best to enter each title with the capitalisation that you think you will most often 
need. Most journals seem to use “sentence” style for bibliographic titles (use a 
capital only for the first word or any subsequent proper nouns). 
 
4. Press Tab and then in the Journal field type the journal name: 
 

Journal of Petrology 
 
You also have the option, with this and many other journal names, of entering 
the journal name in an abbreviated format such as J. Petrology or J Petrology. 
There is no flat rule – some journals like to use an abbreviated form in their 
bibliographies, while others insist on the full title. When you set up a formatting 
style, how can you tell EndNote which to use for the bibliography that you’re 
formatting right now? The answer to that one lies in what EndNote calls a 
journals terms list, which is a file that you can tuck into your EndNote library that 
lists full-name and several abbreviated-name equivalents for many journals. In 
setting up a formatting style for a particular journal you can then tell EndNote 
which one to use. 
 
If the journal requires, say, full journal names but you have some abbreviated 
names in your library, EndNote can consult the terms list and choose the correct 
format to use for each reference – automatically. To be successful in this respect 
you will have to find a suitable journals terms list that somebody has compiled 
for your field of study, and the journal in question must be included in that terms 
list. For more information, go to www.crandon.com.au and check the home page 
links to “Terms list Earth Sciences” and “Terms Lists UQ”. 
 
Now press Tab and enter 7 in the Volume field, Tab twice to skip Issue (not 
relevant to this reference) and enter 454-488 in the Pages field. Page ranges can 
be entered either in full (e.g. 454-488) or abbreviated (e.g. 454-88). 
 
 
This is all the information necessary for basic bibliography formatting of a 
reference to a Journal Article, and you need no more for this exercise. However 
you should scroll down the New Reference window to see the other fields that 
might be added where appropriate. Note the Abstract and Notes fields, in which 
you may or may not ever wish to type an entry (but Abstract at least is often 
filled by on-line downloads). If necessary these fields can hold about 64k of 
characters, equivalent to around 10 – 12 typed pages. If that’s not enough, 
EndNote also allows you to attach an independent text file to any reference, and 
you can put anything within reason into such an attached file (see below). 
 
When you are ready, select Close Reference from EndNote’s File menu. You 
should now be able to see the reference data you have just entered in the 
Preview Tab Pane, formatted in whatever style you have selected in the drop-

http://www.crandon.com.au/
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down menu at top left of the List window. Try selecting a few different styles in 
that menu and noting the effects on the formatting of the reference data. 
 
Now see how you get on entering the data for another new reference: 
 
Park, C.F., jr, 1968. Affluence in Jeopardy. Freeman, Cooper and Company, 
San Francisco. 
 
(Hint: Be careful – this is a Book, not a Journal Article!) 
 
And finally try this one, which is a chapter in an edited book; EndNote treats it as 
a Book Section type: 
 
Barton, P.B., jr, Skinner, B.J., 1967. Sulfide Mineral Stabilities. In: Barnes, 
H.L. (Ed.), Geochemistry of Hydrothermal Ore Deposits. Holt, Rinehart and 
Winston, Inc, New York, pp. 238-326 
 
See how each formats in the Preview pane. Did you note that you didn’t need to 
enter the “In: “ in the last reference? EndNote does it for you when formatting. 
And if you’ve got this far OK then  you should be getting the idea by now! 
 
 
Attaching a File to a Reference 
 
You may have noticed, when scanning the fields available for the entry of a new 
reference, that way down the list (after Keywords, Abstracts, Notes etc) there is a 
field called File Attachments. You can make use of this field to attach almost any 
kind of file to the reference – maybe a photograph or a figure, or perhaps some 
external text notes relevant to that particular reference. In fact you can make use 
of this field to attach up to 45 different files to any one reference. In particular 
you can use it to attach PDF files, possibly a copy of the complete original 
reference. You place a link in the File Attachments field to the attached file, which 
is stored in the library Data folder. It can be accessed at any time by clicking on 
the icon representing that link. 
 
To try this out, make sure that you have access to a suitable file somewhere on 
your computer. Any file will do, but a PDF file provides a good demonstration. If 
you don’t have any others readily available, you can use the 
GettingStartedGuide.pdf file installed in the EndNote Program/Application folder 
when you installed EndNote. Make sure you know how to navigate to the chosen 
file. 
 
Now open a sample reference – say one of the references that you created in the 
exercise above. Of course it will not actually be relevant to the PDF file, or vice 
versa, but here we are only looking at the procedures involved. 
 
Choose File Attachments > Attach File… from EndNote’s References menu. 
This will bring up a dialog box which should contain a check box labelled “Copy 
this file to the default file attachment folder and create a relative link”. Make sure 
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that this box is checked. Then simply navigate to your chosen PDF file, click on it 
to select it, and click Open in the file attachment dialog. You should see an icon 
with the PDF file name appear in the File Attachments field of the open reference. 
Close the reference window to save the link, and then re-open it. 
 
Double-click that icon, and you should see the chosen PDF file immediately open 
automatically in whatever application you have set up on your computer to open 
PDFs (or whatever file type you used for this exercise) 
 
More and more referenced articles are being made available on-line as PDF files, 
some of them by the publishers of the original article (typically at some expense, 
but this may well be warranted for key articles) and others by the authors 
concerned or some other organization. If the on-line file has been properly 
prepared with complete document identification EndNote may be able to find it 
on-line and add it to the appropriate reference.“Complete document 
identification” means that the file must include a properly-prepared, valid “DOI” 
(“Digital Object Identifier”). This is usually supplied by the publisher, and many 
PDFs do not have it. 
 
 
Downloading references from on-line sources 
 
There are several possible ways in which you can search for relevant reference 
data in different on-line sources, and download the results of your searches 
directly into an EndNote library. This can sometimes provide you access to 
references that you didn’t even know about. The downloads in many cases 
contain full abstracts, and in a growing number of cases it is even becoming 
possible to download full-text versions of the original publications. 
 
Such download procedure avoid much of the tedium of typing involved in 
manual data entry, although some editing of the downloads is sometimes 
required for best results. 
 
The catch is whether or not you have access to any of the on-line sources that 
might be relevant to your personal interests. As noted earlier, most of them are 
commercial and access to them requires some kind of licence, which is usually 
not inexpensive. The libraries of most major educational institutions often 
subscribe to the more popular on-line sources, and you may be fortunate enough 
to have access to some of them through this channel. It is impossible to 
generalise, and we can only recommend that you search out your own options. 
However we include here a brief exercise, based on the free PubMed database, to 
demonstrate the possibilities to you. 
 
Although primarily a medical-health database, PubMed is not without some 
versatility, as this exercise will show. However you should not expect it to be of 
much help with topics in mining engineering (other than broken bones!). The 
following exercise will show you the kind of results that you can get from any of 
several different ways of seeking information on-line. It assumes, of course, that 
you have Internet access from your computer, and also that you will not 
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encounter problems with a proxy server on your institutional network, set up to 
protect against unauthorised access to the network. If you encounter these 
problems you will need to resolve them with your network administrator. 
 
(And a quick check showed that at the time these notes were written PubMed 
actually yielded nearly 20,000 references containing the word “mining” in key 
fields!) 
 
 
PubMed import 
 
You should probably pass up this exercise if you happen to have dial-up internet 
access; the downloading involved may take up lots of time. A faster ADSL or 
wireless connection is to be preferred. 
 
1. Open an EndNote library. You can use the Sample Library for this exercise, or 
you can open a new library (from EndNote’s File menu select New, name the 
new library and specify where it is to be stored), use it to experiment, and delete 
it later. 
 
2. From EndNote’s Tools menu, select On-Line Search… . This should bring up a 
dialog with the list of connection files stored in your EndNote folder. Again it is an 
abbreviated list, and the on-line source you want may not be listed there. If 
so, check the files available for download on the http://www.endnote.com site 
(under Support and Services). 
 
3. For the present, just scroll to  PubMed (NLM), click on it to select it, and then 
click on the Choose button. The Tab pane at the bottom of the library List 
window should then change to look something like this: 
 

 
 
Notice that the Search tab at the top of this pane now reads “Online Search – 
PubMed MEDLINE at PubMed (NLM)” (instead of just “Search”). The drop-
menu at the bottom of the pane reads “Search Remote Library”. 
 
4. For the first line of search criteria, leave (or set) the first two fields to “All 
Fields” and “Contains”. In the third (blank) field type the word “trilobite”. 
 
5. In the second search line, change the “And” to “Not”, and in the blank field 
type “zebrafish”. The pane should now look like this: 
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So you are asking PubMed to search its reference database for any references 
that contain the word “trilobite” in any field, but not including those that also 
have the word “zebrafish” in any field. 
 
6. The Search button at lower left should now be highlighted. Click on it to start 
searching a very large database way over on the other side of the world. So the 
search may take a few seconds (5, maybe 10?). 
 
7. A dialog will report the results of the search and ask if you wish to import the 
found references into your EndNote library: 
 

 
 
 
8. If you click on OK EndNote will open a new window in the open library and 
the references will be imported into that new window (so that you can inspect 
the references one by one, if you wish, and delete any unwanted ones before the 
search results are actually added to your library). Open a few of the downloaded 
references to check the range of information that you get. 
 
The remote database link will remain open until you close the library or shut 
down your internet connection. 
 
 
A reminder — this exercise is purely illustrative, to show the power of on-line 
access by using a database that everyone can access. However PubMed will 
prove to be of limited value if you work outside the medical-biological area, and 
you will need to make your own investigation to find the databases of more 
direct interest to your own needs. When ready, you are strongly urged to read 
the relevant sections of the GettingStartedGuide.pdf document, and also the 
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more detailed EndNote Help file, for more information on the use of on-line 
sources. 
 
At the time of writing, another free access database in the form of Google Scholar 
(ask for it in Google) is in a promising beta development stage. Keep an eye on it 
– you may already find it to be very useful. It can download search-located 
references to EndNote (you need to set this option in its Preferences) and 
already has a fairly good database to draw on. Right now, as this is being written, 
it has a minor drawback in that it can only download one reference at a time, but 
hopefully this limitation will disappear in the future. 
 
 
Writing a paper with EndNote and Word 
 
Please work through this exercise only if you are using a relatively recent version 
of EndNote (we suggest version X1 or later) with one of the following: 
 
Microsoft Word for Windows 2003, 2007 or 2010, or 
 
Microsoft Word for Macintosh 2004, 2008 or 2011. 
 
If you are using EndNote with OpenOffice.org Writer (Windows) or with Apple’s 
Pages (Macintosh) you will find detailed instructions for using EndNote’s cite-
while-you-write (“CWYW”) facility in the EndNote Help manual. If you are using 
another word processor with RTF document formatting you can also find 
instructions in the Help support, either on-screen or by downloading a printable 
PDF version of the manual from EndNote’s web site at www.endnote.com (go to 
Support and Services and check the Downloads listing). 
 
While you can always switch from your word processor to EndNote or back 
again while writing in any word processor, the CWYW facility actually inserts 
EndNote commands into Word’s Tools menu (or an EndNote tab in later versions 
of Word for Windows), so that you can perform key formatting functions as you 
write, without leaving Word and without having to close the document in Word, 
open it in EndNote to process it, and then close it in EndNote and re-open it in 
Word to see the results. The savings in time and convenience are considerable. 
 
Begin by opening Word and EndNote (remember that if the CWYW preferences 
have been set appropriately Word will automatically open EndNote when it is 
started itself). If EndNote is not open, open it by going to Word’s Tools > 
EndNote Xx > Go to Endnote (or go to the EndNote tab in Word 2007 or 2010). 
 
For this exercise it is convenient to use the same procedures as the 
GettingStartedGuides because the appropriate references are present in the 
Sample_Library. So make sure that the Sample_Library is open; if necessary open 
it from EndNote’s File menu. 
 

http://www.endnote.com/


27 
 

Word 2003 (Windows), 2004, 2008 or 2011 (Macintosh): From Word’s 
Tools menu, select the EndNote Xx sub-menu (e.g. EndNote X4), and from that 
sub-menu select Cite While You Write Preferences… : 
 
Word 2007 or 2010 (Windows): Remember, these versions of Word have no 
Tools menu. Instead the EndNote CWYW commands are accessed from an 
EndNote tab, on which you can click the Preferences command: 
 
Uncheck the box labelled Enable Instant Formatting on new Word documents: 
 

 
 
(We suggest you do this initially – though only temporarily – to give you a clearer 
idea of the formatting process that CWYW will subsequently perform 
automatically.) 
 
In EndNote (you can click on any exposed portion of the EndNote screen window 
to switch to EndNote; click anywhere on an exposed part of Word’s screen 
window to switch back to Word), select Author-Date as the current style in the 
drop-down menu at top left of the library List window.  
 
(If this style doesn’t appear in the drop-down menu, click on Select Another 
Style, locate Author-Date in the list of attached styles, click on it to select it, and 
click on the Choose button – this procedure should add Author-Date to the list of 
styles immediately available to EndNote.) 
 
Now open a new Word document, in which you can enter some manuscript text 
and some citations of references in the Sample_Library. Begin by typing the 
following text (the same example as used by the GettingStartedGuide): 
 
The fossil in question was generally considered to be the 

220 million year-old remains of Tyrannosaurus. Several 

years ago, however, Morehouse overturned this hypothesis 

with the discovery of yet another species. 
 
Type a couple of blank lines, then the bibliography title “References”, and 
another blank line. Return the cursor to the end of the last word (“species”), and 
insert a space before the period/full stop. Leave the cursor there – it is the mark 
to tell EndNote where you want to place a reference citation in the text. 
 
Now we need to enter a citation to Morehouse’s paper. If you are using a version 
of Word that has a Tools menu, select Find Citation(s) from the EndNote Xx 
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sub-menu. (You could also click the Find Citations icon on the EndNote toolbar in 
Word (Macintosh). If you have no Tools menu, click Insert Citation in the 
Citations group on the EndNote tab. 
 
 
The Find & Insert My References dialog should appear. Type the author name 
Morehouse in the text box at the top of the dialog, and press Enter/Return on the 
keyboard: 
 

 
 
You will see that the upper part of the dialog displays a list of all of the 
references in the Sample_Library (in this case only one) that contain 
“Morehouse” in any of the Author or Title fields. The lower part of the dialog 
displays all the data from the Morehouse entry in the Sample-Library, so that you 
can be sure that this is indeed the reference that you want. 
 
Now click on the Insert button, and you should find that your typed text now 
reads: 
 
The fossil in question was generally considered to be the 

220 million year-old remains of Tyrannosaurus. Several 

years ago, however, Morehouse overturned this hypothesis 

with the discovery of yet another species {Morehouse, 

1993 #120}. 
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References 
 

Save the document under a suitable name – e.g. My Test Document.doc(x). 
 

What EndNote has done has been to insert a temporary citation at the cursor 
position. The temporary citation is to a reference in the Sample_Library which 
has Morehouse as the first (or only) author, the year of the reference, and the 
number of the record for that reference in the library database – in this case 
#120 (yours may have a different number, although probably not unless you 
have played around with the Sample_Library). 
 
This information has been enclosed within curly braces { } and inserted in the 
Word text. The use of curly braces instead of regular parentheses ( ) or square 
brackets [ ] is critical. Curly braces are what EndNote uses by default to 
recognize an EndNote temporary citation in the text. If you use them for anything 
else in your text you will produce error messages when EndNote is formatting 
citations, as it tries to make bibliographic sense out of whatever you have put 
between them (and will almost invariably fail). You can in fact set EndNote 
preferences to use other citation markers, but you should then be equally careful 
not to use those markers for anything other than EndNote citations. 
 
Now go to Word’s Tools menu, if your version of Word has one (otherwise go to 
the EndNote tab – see below), select EndNote Xx and Format Bibliography … 
from the sub-menu. This should produce a new dialog 
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Check that the Format Bibliography tab is highlighted and that the document 
name and formatting style are correct. Click the OK button. 
 
If your Windows version of Word has no Tools menu, click on Update Citations 
and Bibliography in the EndNote tab. 
 
You should now find that your document changes magically to a new version in 
which the in-text citation has been formatted to the specifications of the Author-
Date style, so that it now appears as (Morehouse and Tung 1993), with regular 
curved parentheses, and the full reference has been added to the bibliography, 
also formatted to Author-Date specification: 
 
The fossil in question was generally considered to be the 

220 million year-old remains of Tyrannosaurus. Several 

years ago, however, Morehouse overturned this hypothesis 

with the discovery of yet another species (Morehouse and 

Tung 1993). 

 

References 

 
Morehouse, S. I. and R. S. Tung (1993). "Statistical 

evidence for early extinction of reptiles due to the 

K/T event." Journal of Paleontology17(2): 198-209. 

 
 
(Author-Date is an EndNote style designed to serve for the popular “Harvard” 
style, for which there are in fact many ill-defined variants.) 
 
Now return briefly to the Format Bibliography dialog (Tools > EndNote Xx > 
Format Bibliography…(or access it from the EndNote toolbar, or the EndNote 
tab in Word). Click on the Instant Formatting tab, click the button to Turn On 
instant formatting, and click OK. If you don’t have a Tools menu, select 
Preferences from the EndNote tab and check Enable Instant Formatting on new 
Word documents. EndNote should now format your citations instantly, as you 
enter them, instead of requiring a separate formatting process. 
 
Next, add another sentence to the text of your manuscript: 
 
It is now the undisputed progeny of the species at hand 

 
As usual, leave the cursor at the end of the word “hand”, with one intervening 
space. Here you wish to add a citation to a reference supporting this statement. 
Go to Tools > EndNote Xx > Find Citations …, and type 1987 (+ Return/Enter) 
into the search text field at the top. Or go to Insert Citation > Find Citation in the 
EndNote tab in Word 2007 or 2010, type 1987 in the search text field at the top 
of the resulting dialog, and click on Find. The paper you want to cite was 
published by Turnhouse in that year. EndNote will display all the references in 
the Sample_Library with 1987 as their publication date, and Turnhouse’s paper 
should be one of them. Click on it to select it, and click on the Insert button. 
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With Instant Formatting now turned on, you will probably have no more than a 
very brief glimpse of the temporary citation inserted at the cursor position. 
Instead CWYW will almost immediately format the citation in the text, and add 
the formatted bibliography entry to the reference list. All done! (From here on 
you will probably have very little need or desire ever to turn instant formatting 
off.) 
 
The fossil in question was generally considered to be the 

220 million year-old remains of Tyrannosaurus. Several 

years ago, however, Morehouse overturned this hypothesis 

with the discovery of yet another species (Morehouse and 

Tung 1993). It is now the undisputed progeny of the 

species at hand (Turnhouse 1987). 

 

References 

 
Morehouse, S. I. and R. S. Tung (1993). "Statistical 

evidence for early extinction of reptiles due to the 

K/T event." Journal of Paleontology17(2): 198-209. 

Turnhouse, M. B. (1987). "Role of 14C dating in 

paleontology." Journal of Paleontology75(6): 11-15. 

 
You can format, and re-format, and re-format a manuscript as many times as you 
like, in the same or different styles (with a little diligence you can experiment 
with up to nearly 5000 different styles, although those delivered with your 
EndNote installation should be more than enough for simple experimentation). 
 
 
Editing Citations 
 
From time to time you will need to make adjustments to some of the citations in 
your manuscript, or to insert citations in different ways. Suppose, for example, 
that you decide to express the last sentence in another form which is common in 
many publications. You would like it to read 
 
Turnhouse (1987) showed that it is now the undisputed 

progeny of the species at hand. 
 
In your manuscript, delete the last sentence and replace it with 
 
Turnhouse | showed that it is now the undisputed progeny 

of the species at hand 
 
leaving the cursor in the position shown after the word “Turnhouse” – with one 
space either side. Now use the Find Citations procedure to locate and insert the 
Turnhouse citation, exactly as you did before. The manuscript should now read 
 
Turnhouse (Turnhouse 1987) showed that it is now the 

undisputed progeny of the species at hand 
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which is not yet quite what you wanted. The year is fine, but not the repeated 
author name. You might also want to add a prefix or a suffix to the year citation, 
for example to have it read “Turnhouse (1987, p. 205) …” 
 
So now go to Tools > EndNote Xx > Edit & Manage Citations … (or Edit & 
Manage Citation(s) on the EndNote tab): 
 

 
 
(As usual, the Windows version will be slightly different in appearance, but not 
in essential content.) 
 
Click on the Turnhouse reference to select it, and check the Exclude author box. 
Then in the Suffix text field, type “, p. 205” (don’t type the quotes, and remember 
to type a leading comma and space before the “p. 205”). 
 
Click OK, and you should have what you wanted: 
 
The fossil in question was generally considered to be the 

220 million year-old remains of Tyrannosaurus. Several 
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years ago, however, Morehouse overturned this hypothesis 

with the discovery of yet another species (Morehouse and 

Tung, 1993). Turnhouse (1987 p. 205) showed that it is 

now the undisputed progeny of the species at hand. 
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Note that you also have the option to exclude the year from an in-text citation, or 
even to exclude both author and year. Why would you ever want to exclude 
both? Because that would result in the reference being included in the 
bibliography without being visibly cited in the text. You may have reasons for 
wanting to do this, although most editors would be unhappy if you do! 
 
As usual, there are other ways of editing citations to produce these special 
results, but the procedure listed above is easy to remember and apply. The 
important thing to remember is that you should not try to edit formatted 
citations directly in the text, using normal word-processing procedures. To edit 
citations, always use EndNote’s built-in citation editing procedures. 
 
 
Multiple citations 
 
You will often need to cite several different references at the same point in your 
manuscript. You use exactly the same procedure as that outlined above for a 
single reference, but first collect all the desired references and insert them 
together. 
 
For example, type a further sentence at the end of your hypothetical manuscript: 
 
Most authorities now agree with this interpretation | 

 
And leave the cursor one space after the last word. 
 
Go to Tools > EndNote Xx > Find Citation(s)… and enter “dinosaur” in the 
Search text field, followed by the Return/Enter key to make the search. The 
resulting dialog should show a number of “dinosaur”-bearing references in the 
Sample_Library. Select several of them by clicking on each while holding down 
the Control key (Windows) or Command key (Macintosh), and then click on 
Insert. You should get something like this: 
 
The fossil in question was generally considered to be the 

220 million year-old remains of Tyrannosaurus. Several 

years ago, however, Morehouse overturned this hypothesis 
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with the discovery of yet another species (Morehouse and 

Tung 1993). Turnhouse (1987 p. 205) showed that it is now 

the undisputed progeny of the species at hand. Most 

authorities now agree with this interpretation(Schwartz 

1976; Whiting, Billoski et al. 1987; Schwartz and 

Billoski 1990; Billoski 1992; Billoski 1993) 
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Note that the Author-Date style specifies that multiple in-text citations are to be 
sorted chronologically, not alphabetically by author name. Other styles may 
specify the opposite. The Author-Date style also specifies the use of “et al.” for 
citations to references with more than two authors; other styles vary widely in 
this respect, but EndNote allows these variations to be controlled with 
appropriate settings in the style specifications. 
 
You are again free to go to Tools > EndNote Xx > Edit & Manage Citation(s)(or 
Edit & Manage Citations on the EndNote tab in Word 2007 or 2010) to make 
editing changes to any citation, even individual citations within a multiple group 
(try it to see, and experiment if you wish). If you are not happy with the sorting 
within a multiple citation, you can move individual citations up or down in the 
sort order, but be careful if you feel the need to do this. Make sure that the order 
you specify is indeed the order that your publisher requires. If the EndNote style 
specification is incorrect, it would be better to edit the style itself so that it will 
always use the correct order. 
 
 
Direct access to a library reference 
 
Although it is usually convenient to do so, you do not need to use the formal Find 
Citations procedure. You can simply go directly to your EndNote library list 
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window, locate one or more references in the list, click on them to select them 
(individually or together in a multiple citation group), return to Word and go to 
Tools > EndNote Xx > Insert Selected Citation(s) (or Insert Citation > Insert 
Selected Citation(s) on the EndNote tab). This may be quicker and more 
convenient if you know exactly which reference(s) in your library that you wish 
to cite at a given point in your manuscript 
 
Instead of always going to the Tools menu, you are sure to find that there is a 
convenient choice available in the icons on the EndNote toolbar in Word 
(Macintosh) or the Citations group on the EndNote tab (Windows), or at the top 
of the List window in EndNote. These are well worth a little more experimenting. 
 
 
Quick access to CWYW functions 
 
Many times in the procedures outlined above you have been urged to go to 
Word’s Tools menu and select some function from the EndNote Xx sub-menu, or 
to make similar selections from the Endnote tab in Word 2007 or 2010. All of 
these functions are easily accessible simply by clicking on an icon in the EndNote 
toolbar that you should find somewhere on the Word screen (Macintosh), or the 
EndNote tab in Word (Windows): 
 

 
(Macintosh) 

 
 

 
 

(Windows) 
 
 
If the Macintosh EndNote toolbar is not showing in the Word window, but 
everything else seems to be O.K., go to Word’s View menu, select Toolbars, and 
ensure that an EndNote Xx toolbar is shown in the toolbars list and checked. If it 
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is not in the list there has been a problem with your EndNote installation. If it is 
on the list and checked, have another close look around the Word window – it’s 
probably there somewhere! 
 
 
Submission of your manuscript 
 
When your manuscript is finished and you wish to submit it to a journal for 
editorial consideration, you have several options. The one you choose will 
depend on editorial policy, and obviously you need to check on what that policy 
is. 
 
1.If your editor has EndNote facilities and is willing to accept manuscripts in 
EndNote-formatted form, then by all means submit a copy of your final MS, as is. 
Before submitting, be sure to make at least one backup copy (two is better!), and 
also a backup copy of your EndNote library file at the time you completed 
writing; preferably get the backup copies off-site (see below). You should also 
check that the editor is using the same, or very nearly the same version of Word 
that you are (some Word versions may be mutually incompatible). 
 
Once upon a time it was necessary to send a copy of your EndNote library file to 
the editor, along with any EndNote-formatted manuscript. This is no longer the 
case, as every EndNote-formatted Word manuscript now contains a Travelling 
Library – a compact, built-in version of your library, containing all the essential 
bibliographic information used in your manuscript. Your editor can use the 
travelling library to make any necessary corrections to your citations or 
bibliography. 
 
2. On the other hand, if the editor does not have EndNote facilities available, or 
does not wish to edit submitted documents at the EndNote level (e.g. 
modifications to citations or bibliographies) then you will need to strip the 
hidden EndNote codes from your manuscript. Under certain conditions those 
codes can create considerable confusion if they are handled outside normal 
Word/EndNote control. (Specifically, EndNote inserts its instructions into the 
Word manuscript in the form of what are called field codes. Word commonly has 
its preferences set to hide these field codes so that the user doesn’t see them – 
only their formatting effects. However if the Word preferences are not correctly 
set, you will see the codes rather than their effects. The manuscript then appears 
to be full of absolute gobbledygook.) 
 
In this case, you should submit your manuscript with the field codes removed 
and only their formatting effects permanently displayed instead. First make at 
least one backup copy of the manuscript and store it in a safe place. Then open 
the manuscript in Word, go to Tools > EndNote Xx and select Remove Field 
Codes. EndNote will then delete all of the CWYW field codes (but not other field 
codes, which Word also uses for other purposes) and it converts all of the 
formatted citations and bibliography to text. 
 
In Word 2007 or 2010 (Windows), go to the EndNote tab, and, in the 
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Bibliography group, select Convert Citations and Bibliography . Then Convert to 
Plain Text . A copy of the document, without field codes, appears in a new 
document window.  
 
The conversion process is not reversible – once the codes are gone they are gone, 
and you cannot use EndNote to reformat the document. So EndNote recognizes 
this and actually makes a copy of the document with codes removed, retaining 
the original. But it was a good idea to make that backup first! Note that removing 
the field codes also removes the Travelling Library. You will not be able to use 
CWYW for any further re-formatting of the “stripped” document, which is why 
you must be very careful of saving the original. You can always go back to that, as 
long as you still have the corresponding EndNote library. 
 
After the field codes have been removed by either of the above procedures  a 
new copy of your document, with codes removed, will appear in a new document 
window. Save it in the usual way. Use the Save As… to give the “stripped” 
document a new name. Don’t attempt to save it with the same name as your 
EndNote-formatted manuscript, as you might then over-write and lose the latter. 
 
Removing field codes can have some effects on EndNote’s in-text figure citations. 
Consult EndNote’s Help file for details. 
 
 
 
Final advice 
 
Our parting advice to you consists of three words: 
 

Backup   …..        Backup     …..     BACKUP!!! 
 
Unfortunately at Crandon Services we still get far too many panic-stricken 
service calls along the lines of “my thesis is due in two days and I’m trying to do 
the final formatting and my EndNote library has disappeared or has refused to 
function since I spilled half a cup of coffee on my keyboard and I don’t have 
another copy — please help me!” 
 
Sadly, we usually can’t. Please make determined efforts to maintain adequate 
backup copies of your EndNote libraries and your Word documents. And 
remember – a second copy on the same hard disk as the first is not a very 
satisfactory backup. If the disk crashes, which is not so common these days but is 
certainly not unknown, you will lose both copies and be left with nothing. 
 
Always try to backup to a physically separate disk, or to a USB flash drive or 
equivalent that you can take away and keep in a completely separate place. A 
Dropbox might be a good idea – if you don’t know about Dropboxes ask around. 
And back up frequently – at least whenever it will take you more than an hour or 
two to repeat what you have done since the last backup. Everybody agrees with 
the frequent backup philosophy, but far too many people still fail to practise it! 
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